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Chú ý: Nếu bạn chưa dùng WinVNKey thành thạo, xin đọc trước bài  

“Vài Chức Năng Đặc Biệt Của Phần Mềm Gõ Winvnkey” ở 

http://chuvietnhanh.sf.net (phần Bài Đọc Thêm) để làm quen trước. Sau đó, 

nếu muốn tìm hiểu sâu hơn hoặc muốn khám phá các chức năng cao cấp 

hơn thì hãy đọc bài này.   

  

WinVNKey là phần mềm miễn phí để gõ chữ Việt và các ngôn ngữ khác. Ngoài các chức năng giúp 

gõ chữ Việt được chính xác hơn và nhanh hơn, WinVNKey còn có rất nhiều chức năng mà các 

phần mềm khác chưa hỗ trợ hoặc có hỗ trợ nhưng chưa hoàn hảo.  

 

Phần mềm WinVNKey có thể được hạ tải từ http://winvnkey.sf.net.  WinVNKey có thể được cài 

đặt ở giao diện tiếng Anh hay tiếng Việt.  Bài viết này dùng giao diện tiếng Việt hầu giúp cho 

đông đảo người Việt khắp nơi trên thế giới.  Một số các chức năng của WinVNKey nằm ở các 

hyperlink màu xanh (Hình 1).  Chẳng hạn muốn thay đổi dấu của các kiểu gõ, ta nhấn lên cụm 

chữ "Kiểu gõ" ở trang Chính.  Ngoài ra WinVNKey còn cung cấp các chức năng khác thông qua 

menu ở nút "Chạy" (Hình 2). 

 

http://www.facebook.com/plugins/like.php?href=http%3A%2F%2Fchuvietnhanh.sourceforge.net%2FTimHieuMotSoChucNangDacBietCuaPhanMemGoWinvnkey.htm&width&layout=box_count&action=like&show_faces=false&share=true&height=65
https://www.facebook.com/sharer/sharer.php?u=http%3A%2F%2Fchuvietnhanh.sourceforge.net%2FTimHieuMotSoChucNangDacBietCuaPhanMemGoWinvnkey.htm&display=popup
https://twitter.com/intent/tweet?original_referer=https%3A%2F%2Fabout.twitter.com%2Fresources%2Fbuttons&text=Twitter%20Buttons%20%7C%20About&tw_p=tweetbutton&url=http%3A%2F%2Fchuvietnhanh.sourceforge.net/TimHieuMotSoChucNangDacBietCuaPhanMemGoWinvnkey.htm&via=chuvietnhanh
http://chuvietnhanh.sf.net/VaiChucNangDacBietCuaPhanMemGoWinvnkey.htm
http://chuvietnhanh.sf.net/
http://winvnkey.sf.net/
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Hình 1: Giao diện chính của WinVNKey. 

 

 

 
 

Hình 2: Một số chức năng của WinVNKey nằm ở nút Chạy. 

 

Bài này xin được giới thiệu vài chức năng hữu dụng đặc biệt của WinVNKey như sau:  

 

- Sửa các chữ biến dạng trong email (vd: Yahoo mail, Hotmail …). 

- Hoán đổi chữ hoa/thường, chữ hoa đầu câu, đầu từ cho văn bản chữ Việt. 

- Tra dấu Hỏi Ngã. 

- Hỗ trợ bảng ký tự (Character Map). 

- Hoán chuyển bảng mã cho văn bản trơn (plain text). 

- Hoán chuyển văn bản viết dưới dạng Telex, VNI, VIQR (VietNet). 

- Tự động gõ lại văn bản. 

- Hoán chuyển văn bản định dạng RTF (rich text format). 
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1. SỬA CÁC CHỮ BIẾN DẠNG HOẶC Ô VUÔNG TRONG EMAIL  

 

WinVNKey có thể chỉnh lại chữ trong email đã bị biến dạng nhiều lần do không chọn UTF-8 đúng 

cách hoặc phục hồi lại các chữ bị hiển thị thành ô vuông.  

 

Dưới đây là ví dụ thật đã xảy ra. Ta có thể dùng để thực tập: 

  

Tôi hỏi Vinh, bạn tôi, giúp tìm phần mềm hoán chuyển chữ Việt không dấu qua chữ có dấu. Khi 

mở email trả lời của Vinh (viết bằng chữ không dấu), phần email mà tôi đã gởi cho Vinh viết bằng 

chữ có dấu đã bị biến dạng. Nguyên văn email của Vinh như sau: 

 

Hello anh Binh 

Anh vao vovisoft trong do co muc chuyen tu nhung chu khong dau qua co dau nhung khong 

dung phan mem. 

Vay nhe anh binh. 

Vinh 

 

> tu binh tran <tubinhtran@gmail.com> wrote: 

> 

> Hi Vinh, 

> HÃ´m trÆ°á»›c, nghe Vinh nÃ³i vÃ o site cá»§a vovisoft.com cÃ³ thá»ƒ 

> tháº¥y software hoÃ¡n chuyá»ƒn chá»¯ Viá»‡t khÃ´ng dáº¥u qua chá»¯ Viá»‡t cÃ³ 

dáº¥u. 

> TÃ´i cÃ³ vÃ o tÃ¬m nhÆ°ng khÃ´ng tháº¥y. 

> Váº­y Vinh xem láº¡i vÃ  cho tÃ´i cÃ¡i link dáº«n tá»›i software nÃ y nha. 

> Cáº£m Æ¡n Vinh. 

> Tráº§n TÆ° BÃ¬nh 

 

Để đọc đoạn email biến dạng trên, ta làm vài bước như sau: 

 

- Chọn bôi đen [select] đoạn email biến dạng.  

- Nhấn thả phím Ctrl 2 lần, xong đè chuột phải 

- WinVNKey sẽ hiển thị bảng trình đơn (menu) như Hình 3. 

- Chọn “E6. Sửa các chữ biến dạng trong email”. 

- Tức thì sau vài giây, toàn bộ đoạn email bôi đen trên sẽ được phục hồi lại dạng tiếng 

Việt nguyên thủy và hiển thị trong một cửa sổ trình duyệt mới. 

- Nếu có một số chữ không hoán chuyển được, ta có thể lặp lại quá trình hoán chuyển vừa 

rồi nhưng chọn menu E5. 
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Hình 3: Bảng trình đơn của WinVNKey sau khi nhấn Ctrl 2 lần và đè chuột phải. 

 

Chú ý rằng menu E5 (hoặc E6) cũng có thể dùng để sửa lại email có những ký tự hình vuông như 

trong Hình 4. Sau khi hoán đổi, ta sẽ được Hình 5. 

 

 
 

Hình 4:  Yahoo Email bị lỗi ô vuông khi hiển thị một số mẫu tự Việt 

 

 

 
 

Hình 5:  Email sau khi sửa xong được hiển thị ở một cửa sổ trình duyệt mới. 
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2. HOÁN ĐỔI DẠNG CHỮ HOA/THƯỜNG 

 

WinVNKey có thể hoán đổi dạng chữ hoa/thường, chữ hoa đầu câu, chữ hoa đầu từ, cho văn bản 

được viết bằng bất cứ bảng mã nào trong số gần 100 bảng mã mà WinVNKey hỗ trợ: Unicode, 

VISCII, ABC, VNI, VPS, v.v. Muốn vậy, trước khi hoán đổi, ta phải chọn lựa đúng bảng mã ở trang 

Chính. 

 

Microsoft Word cũng có chức năng hoán đổi Unicode dạng chữ hoa/thường [Format > Change 

Case] nhưng chỉ áp dụng cho các chữ viết theo lối dấu rời (composed characters). Khi gặp chữ 

Việt Unicode dựng sẵn (precomposed characters), Microsoft giữ nguyên không hoán đổi ngoại trừ 

khi chữ đó trùng với những chữ dùng ở Tây Âu (như đ, à, á, ã, è, é, ù, ú, …). Chẳng hạn, khi 

chọn đổi sang chữ hoa, Microsoft Word sẽ đổi cụm chữ "Hoán đổi" thành ra "HOÁN ĐổI".  Nếu 

gặp văn bản viết bằng các bảng mã Việt cũ (như ABC, VPS, …) Microsoft Word sẽ hoán đổi sai vì 

nó không hiểu những bảng mã này. 

 

Trong khi đó WinVNKey cũng có đầy đủ chức năng hoán đổi Unicode dạng chữ hoa/thường y hệt 

như Microsoft Word (nghĩa là hỗ trợ tất cả các ngôn ngữ trên thế giới). Ngoài ra WinVNKey còn 

vượt trội hơn Microsoft Word ở những điểm sau đây: 

 

(1) Hỗ trợ cho tất cả chữ Việt Unicode dạng dựng sẵn. 

(2) Hỗ trợ cho tất cả văn bản viết bằng bảng mã Việt cũ như ABC, VPS, v.v. 

(3) Khả năng hoán đổi hoa/thường của WinVNKey có thể hoạt động với bất kỳ editor nào 

(như Word, Wordpad, Notepad, Email, browser, v.v.) chứ không phải bị giới hạn trong 

Microsoft Word mà thôi. 

 

Sau đây là cách hoán đổi bằng WinVNKey: 

 

- Chọn bảng mã ở trang Chính cho phù hợp với bảng mã của văn bản (thông thường là 

bảng mã Unicode). 

- Chọn bôi đen [select] đoạn văn đó. 

- Nhấn thả phím Ctrl 2 lần, xong nhấp chuột phải. 

- WinVNKey sẽ hiển thị bảng trình đơn (menu) như Hình 3. 

- Nhấn một tùy chọn thích hợp (từ A1 đến A5) để hoán chuyển sang chữ hoa/thường, chữ 

hoa đầu câu, chữ hoa đầu từ, v.v … 
 

Lưu ý: 

Nếu văn bản là các trang Web thì ta phải Sao > Dán [Copy > Paste] vào Microsoft Word hoặc 

WordPad, v.v… rồi hoán đổi từ nơi này. Lý do là các trang Web không cho phép ta thay đổi chữ 

(read-only text), ngoại trừ khi các chữ đó nằm trong các hộp chữ cho phép người dùng gõ vào. 

 

So sánh thao tác giữa Microsoft Word và WinVNKey 

Để so sánh ta sẽ liệt kê các thao tác cơ bản khi chuyển chữ hoa/thường như sau: 

 

(a) Dùng Microsoft Word: 

1. Chọn bôi đen một đoạn văn bản 

2. Nhấn chuột lên tùy chọn Format của MS Word để hiện ra menu 

3. Nhấn chuột lên "Change Case" để hiện ra tiểu menu 

4. Rồi nhấn chuột lên đúng phương pháp hoán chuyển 

5. Kết quả hoán chuyển sẽ lập tức thay thế đoạn chữ bôi đen mà ta không cần phải dán 

(paste) gì cả 

 

(b) Dùng WinVNKey: 

1. Chọn bôi đen một đoạn văn bản 

2. Nhấn thả phím Ctrl hai lần 

3. Đè chuột phải để hiện ra menu hoán chuyển 

4. Rồi nhấn chuột lên đúng phương pháp hoán chuyển 

5. Kết quả hoán chuyển sẽ lập tức thay thế đoạn chữ bôi đen mà ta không cần phải dán 

(paste) gì cả 
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Như vậy, nếu đã quen dùng Microsoft Word và xem như phương pháp của nó là dễ dùng và 

nhanh, ta cũng có thể kết luận cách hoán chuyển của WinVNKey cũng dễ dùng và nhanh như 

Microsoft Word.   

 

Chức năng hiển thị menu bằng cách đè chuột bên phải là một chức năng của Windows mà bất cứ 

ứng dụng nào (Notepad, Wordpad, Word, v.v.) cũng hỗ trợ. Do đó, nếu ta không nhấn thả phím 

Ctrl để báo hiệu cho WinVNKey thì khi đè chuột bên phải ta sẽ được menu của Microsoft Word.  

Sở dĩ WinVNKey cần 2 lần nhấn thả phím Ctrl là để tránh lầm trường hợp người dùng vô tình 

đụng vào phím Ctrl (xem như nhấn thả 1 lần) trước khi đè chuột bên phải. 

 

3. TRA DẤU HỎI NGÃ 

 

Khi gõ chữ Việt mà phân vân không biết dùng dấu hỏi hoặc dấu ngã, ta có thể dùng chức năng 

tra dấu hỏi ngã của WinVNKey. 

 

Để tra dấu, ta làm vài bước như sau: 

 

- Từ trang Chính, nhấn nút [Chạy > Tra hỏi ngã] như Hình 2. 

- WinVNKey sẽ hiển thị bảng “Tra Dấu Hỏi Ngã” như Hình 6. 

- Chỉ cần gõ một từ Việt với dấu hỏi hoặc ngã tùy ý vào ô chữ rồi nhấn nút "Tra chữ".  

WinVNKey sẽ hiển thị một danh sách các từ đơn hoặc phức dùng dấu hỏi hoặc ngã để 

cho ta chọn lựa. 

 

 
 

Hình 6: Bảng Tra Dấu Hỏi Ngã. 

 

Lưu ý:  Ta nên thay đổi phông (font) tương ứng với bảng mã (bộ chữ – charset) mà ta đã chọn ở 

Trang Chính, bằng cách nhấn nút “Đổi phông”. 

Vì cả hai hộp nhập và xuất đều dùng bộ chữ ta đã chọn trong "Trang Chính" của WinVNKey. Do 

đó, ta phải chọn phông thích hợp với bảng mã.  Chẳng hạn: 

- "Arial" cho bộ chữ Unicode. 

- "Sans Serif VISCII 1.1" cho bộ chữ VISCII. 

- "Sans Serif ABC" cho bộ chữ TCVN-3 (tức ABC). 

- Phông với tiếp đầu ngữ "VPS" cho bộ chữ VPS. 

- Phông với tiếp đầu ngữ "VNI" cho bộ chữ VNI. 

- …. 
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4. BẢNG KÝ TỰ (CHARACTER MAP) 

 

Để thuận tiện cho người dùng, WinVNKey cung cấp chức năng hiển thị Bảng ký tự gồm có hàng 

vạn ký tự và ký hiệu rất phong phú để ta có thể lấy ra và chèn vào bài viết. Nó tương tự như 

bảng Symbol của Microsoft Word [Insert > Symbol] nhưng đầy đủ hơn nhiều. Có tất cả hai loại 

bảng ký tự: 

  

a. Bảng ký tự của Microsoft Windows. 

b. Bảng ký tự của WinVNKey (gọi là Bàn gõ chữ Unicode) 

 

Công dụng của hai bảng ký tự tương tự nhau nhưng Bàn gõ chữ Unicode hỗ trợ nhiều chức năng 

hơn, đặc biệt là các chức năng truy cập các chữ Hán Nôm. 

 

A. Bảng ký tự của Microsoft Windows  
 

Đây chính là bảng Character Map của Windows mà ta có thể khởi động bằng một trong hai cách 

sau: 

 

- Từ menu Start > All Programs > Accessories > System Tools > Character Map. 

- Từ trang Chính của WinVNKey: Chạy > Chạy Charmap (xem Hình 2). 

 

WinVNKey sẽ hiển thị bảng Typing Tips (Hướng dẫn gõ) và bảng Character Map như Hình 7.  Dựa 

theo khung Character Map, ta dễ dàng tìm và lấy ra các ký tự tùy thích. 

 

 
 

Hình 7: Bảng ký tự của Microsoft hiển thị chữ tùy theo phông. 
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B. Bàn gõ chữ Unicode của WinVNKey  
 

Từ trang Chính của WinVNKey, nhấn nút Chạy > Chạy Bàn gõ Unicode, ta sẽ được hộp thoại như 

Hình 8. Muốn chọn chữ nào, ta nhấn chuột lên chữ ấy và nó sẽ tự động xuất hiện trong ô "Chữ 

cần chép lại". Ta có thể nhấn lên nút "Chép lại" (copy) rồi dán (paste) chữ ấy vào các văn bản 

khác.   

 

 
 

Hình 8: Bảng ký tự của WinVNKey hiển thị từng vùng mã 

 

Sự khác biệt lớn nhất giữa hai bảng ký tự Microsoft và WinVNKey là số lượng chữ: 

 

• Bảng ký tự của Microsoft chỉ hiển thị khoảng 60 ngàn chữ nằm trong mặt phẳng Unicode cơ bản 

(tức Mặt phẳng số 0). 

• Bàn Gõ Chữ Unicode của WinVNKey có thể hiển thị khoảng 300 ngàn chữ trong chuẩn Unicode 

(gồm Mặt phẳng số 0, 1, 2, 3, 14, 15). 

 

Bàn Gõ chữ Unicode của WinVNKey cho phép hiển thị từng hệ chữ (script/language) như liệt kê 

trong danh sách dropdown của combobox. Mỗi hệ chữ chiếm một vùng mã gồm có một hoặc 

nhiều trang, mỗi trang gồm 128 chữ.   

 

Hàng nút bên phải của Hình 8 cho phép ta truy cập các trang Unicode nhanh chóng. Mỗi lần nhấn 

nút dấu cộng hoặc dấu trừ, ta sẽ lật tới hoặc lật lui một hệ chữ. Mỗi lần nhấn mũi tên ốm, ta sẽ 

lật tới hoặc lật lui một trang. Mỗi lần nhấn mũi tên trung bình, ta sẽ lật tới hoặc lật lui 8 trang. 

Mỗi lần nhấn mũi tên mập, ta sẽ lật tới hoặc lật lui 64 trang. Nếu biết mã số của chữ cần tìm, ta 

có thể dùng menu như Hình 9 bằng cách nhấn nút Hệ chữ > Truy cập chữ. 
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1. Cách chọn phông cho Bàn Gõ Chữ Unicode 

Menu trong Hình 9 cho phép ta chọn phông để hiển thị các chữ trong hộp thoại. Tiếc thay, hiện 

nay không có một phông nào có chứa đầy đủ toàn bộ các chữ Unicode mà chỉ có phông cho từng 

vùng một. Do đó, ta phải chọn đúng phông thì chữ mới hiện ra đúng, còn không thì chữ sẽ hiện 

ra ô vuông trống.  Có hai cách chọn phông: 

 

(1) Dùng chung một phông cho tất cả các vùng chữ Unicode. 

(2) Dùng phông riêng cho từng vùng chữ Unicode 

 

Ta có thể dùng cách (1) để xác định tất cả những vùng chữ mà một phông hỗ trợ. Khi dùng cách 

này thì chỉ có menu A trong Hình 9 là hoạt động, còn các menu khác bị tắt.   

 

Ta có thể chọn cách (2) nếu ta có nhu cầu cần xem nhiều vùng mã khác nhau. Khi chọn cách (2), 

tất cả 13 menu từ B đến G sẽ hoạt động để cho phép ta chọn phông cho từng vùng mã. 

 

 
 

Hình 9: Menu khi nhấn nút Hệ chữ 

 

Nếu có được phông Arial MS Unicode thì rất tốt vì nó chứa rất nhiều ký tự gốc Latin và Hán Nôm.  

Do đó, ta hãy chọn phông này cho menu B, B1, B2, B3 (Hình 9). Nếu không có, ta có thể chọn 

phông Arial hoặc New Times Roman cho menu B, B1. Còn các vùng chữ Hán Nôm thì nên chọn 

phông HAN NOM A cho menu B2, B3, B4 và phông HAN NOM B cho menu D, D1 và G. Chú ý rằng 

phông Arial MS Unicode chỉ hỗ trợ menu B2 và B3 mà thôi. 
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2. Dùng Bàn Gõ Chữ Unicode để hiển thị phông 8-bit 

Tuy tên gọi là bàn gõ Unicode, nó vẫn có thể được dùng để hiển thị các bảng mã 8-bit cũ của 

tiếng Việt (VISCII, VPS, VNI, ABC, v.v) hoặc các bảng mã 8-bit của các ngôn ngữ khác. Các bảng 

mã 8-bit nằm ở vùng mã số dạng U+00xx, tức dùng phông chọn ở menu B1 (Hình 9). Do đó, 

muốn hiển thị bảng mã VISCII chẳng hạn, ta chỉ cần chọn một phông VISCII nào đó cho menu 

A1. Xong nhấp vào hộp combobox để hiển thị hai vùng mã đầu tiên là "Basic Latin (ASCII)" và 

"Latin-1 Supplement" thì sẽ thấy hình của 256 chữ nằm trong bảng mã VISCII. 

 

3. Tại sao gọi là Bàn Gõ Chữ Unicode? 

Bây giờ thì ta có thể hiểu rõ tại sao Bảng ký tự của WinVNKey được gọi là Bảng gõ chữ Unicode.  

Đó là vì bảng ký tự này giúp ta nhập được tất cả các ký tự Unicode không có trên bàn phím bằng 

cách dùng mouse để copy và dán.  

 

Sau đây ta hãy xem công dụng của bàn chữ này khi định nghĩa macro.  Chẳng hạn, ta muốn định 

nghĩa macro $(dù) là chữ Unicode mang mã số U+2602, có hình là ký tự thứ ba trên hàng đầu 

tiên của Hình 8. Nhưng làm sao ta có thể nhập được chữ này khi nó không nằm trên bàn phím?   

 

WinVNKey có nhiều giải pháp cho vấn đề này. Một trong các giải pháp đó là dùng Bàn gõ chữ 

Unicode như sau. Từ trang Chính (Hình 1) nhấn Macro > Tệp Macro > [Chọn Trang Macro số 1] > 

Biên soạn > Thêm. Ta sẽ thấy một hộp thoại hiện ra như Hình 10. Dưới đáy hộp thoại có 3 hộp 

chữ trống. Ta hãy gõ $dù vào hộp thứ nhất. Xong đè chuột phải lên hộp thứ nhì rồi chọn menu 

"Chọn một chữ Unicode".  Lúc đó sẽ xuất hiện một khung như Hình 11, hơi giống như Bàn gõ chữ 

Unicode.   

 

Nếu biết mã số của chữ, ta có thể truy tìm như Hình 9: nhấn "Hệ chữ" > Truy cập chữ > gõ 2602 

vào ô chữ. Còn nếu không biết mã thì ta phải nhấn các nút bên phải (Hình 11) để lật các trang 

hầu tìm ra chữ có hình dù (chữ có mã số U+2602). Sau khi tìm ra chữ rồi, hãy nhấn lên chữ đó.  

Lập tức bàn chữ (Hình 11) biến mất và ký tự hình dù sẽ xuất hiện trong hộp thoại macro ở Hình 

10. Xong nhấn nút "Nhập vào" để nhập macro vào tệp. 
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Hình 10: Dùng menu để nhập chữ Unicode vào cột 2 của macro. 
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Hình 11: Nhấn lên chữ cần dùng để nhập chữ đó vào cột 2 của macro. 

 

 

5. TẠI SAO CẦN HOÁN CHUYỂN BẢNG MÃ TIẾNG VIỆT ? 

 

Hiện nay, đa số chúng ta và hầu như mọi trang mạng Việt ngữ đều dùng phông Unicode để gõ 

chữ Việt. Lý do vì Unicode là mã chuẩn quốc tế, nó hỗ trợ chữ Việt và được cài đặt ngay trong 

Windows. Từ hệ điều hành Windows 98 SE trở đi đều có hỗ trợ hệ thống phông Unicode. Vì đây là 

hệ thống phông chuẩn quốc tế nên khi soạn thảo văn bản chữ Việt bằng phông mã Unicode, 

người ta có thể đọc được chữ Việt tại bất kỳ nơi nào trên thế giới, miễn là máy tính đó có hỗ trợ 

Unicode. Các phông chuẩn của Unicode là: Times New Roman, Arial, Tahoma, Verdana, … 

 

Tuy nhiên các phông mã Unicode không hỗ trợ chữ Việt một cách đa dạng như chữ của các nước 

Âu Mỹ. Để việc in ấn chữ Việt được mỹ thuật hơn, các tờ báo, nhà xuất bản, … vẫn ưa dùng các 

loại phông của các bảng mã khác. Chẳng hạn như: 

 

- Các phông mã TCVN (ABC) có dạng .Vn (dấu chấm ở trước, sau đó đến chữ Vn). Vd: 

.VnTimes, .VnArial, ... 

- Các phông mã VISCII có chữ VI ở trước. Vd: VI Phong Lan, VI Thuy Tien, … 

- Các phông mã VNI có chữ VNI ở trước. Vd: VNI Times, VNI Helve, … 

- Các phông mã VPS có chữ VPS ở trước. Vd: VPS Times, VNI Long An, … 

 

Các văn bản chữ Việt soạn thảo bằng các bảng mã cũ như TCVN (ABC), VISCII, VNI, VPS, v.v. sẽ 

không thể hiển thị đúng được nếu ta không cài đặt các phông tương ứng của các mã trên vào 

máy tính. Bảng mã VNI được sử dụng rộng rãi ở miền Nam và bảng mã TCVN (ABC) được ưa 

chuộng ở miền Bắc. Còn ở hải ngoại thì sử dụng nhiều loại bảng mã như VNI, VISCII, VPS. 

 

Chính vì có nhiều bảng mã Việt Nam khác nhau, mỗi nơi lại sử dụng các bảng mã khác nhau, dẫn 

đến tình trạng không đọc được các văn bản từ trong Nam gởi ra Bắc, hoặc từ trong nước gởi ra 

hải ngoại vì không có phông đúng. Từ đó nảy sinh nhu cầu cần hoán chuyển văn bản sang bảng 
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mã mà máy mình đang có thì mới đọc được. Đó cũng là một trong những mục tiêu của 

WinVNKey. 

 

WinVNKey có thể hoán chuyển bảng mã cho văn bản trơn (plain text) và văn bản định dạng RTF 

(rich text format). 

 

Văn bản trơn là văn bản chỉ gồm có những chữ mà ta gõ vào, chẳng hạn như văn bản do Notepad 

lưu trữ hoặc do Word, Wordpad lưu trữ ở dạng text.  Nếu mở văn bản này ra bằng Notepad, ta 

chỉ thấy có nội dung (tức là chữ mà ta gõ vào văn bản) mà không thấy có dữ liệu về phông và 

định dạng. 

 

Văn bản định dạng RTF là văn bản vừa chứa nội dung lẫn dữ liệu về phông và định dạng (màu 

sắc, đậm lợt, cỡ chữ, loại chữ nghiêng, đậm, v.v.).  Nếu mở văn bản này ra bằng Notepad, ta sẽ 

thấy có rất nhiều cụm chữ lạ không phải là những chữ mà ta đã gõ vào, thỉnh thoảng xen kẻ một 

số chữ nội dung.  Những cụm chữ lạ này chính là những dữ liệu nói về phông và định dạng của 

các chữ trong văn bản. 

 

Chuyển mã văn bản trơn là thay đổi bảng mã của các chữ nội dung trong văn bản mà thôi. Còn 

chuyển mã văn bản định dạng RTF là một việc phức tạp hơn: thay đổi bảng mã của nội dung, 

thay đổi tên phông nhưng bảo toàn kiểu phông: màu sắc, đậm lợt, cỡ chữ, loại chữ nghiêng, 

đậm, v.v. 

 
 

6. CHUYỂN MÃ VĂN BẢN TRƠN 

 

Khi ta mở một tệp (file), chọn một đoạn văn nào đó rồi bôi đen và nhấn CTRL-C là ta đã copy 

đoạn văn đó vào một vùng đặc biệt trong bộ nhớ (memory); vùng này gọi là clipboard hay bảng 

ghi tạm. Như vậy, văn bản có thể được chứa trong tệp, trên đĩa cứng hoặc chứa trong bộ nhớ.  

WinVNKey có khả năng đổi bảng mã của văn bản trơn khi nó nằm trong tệp hoặc trong clipboard. 

 
A. Chuyển mã từ tệp (file)  
 

Để chuyển mã nguyên cả tệp văn bản trơn, ta phải lưu trữ văn bản ở dạng *.txt. Một số editor 

chỉ cho phép lưu trữ ở một dạng duy nhất là dạng văn bản trơn như Notepad. Các word 

processors đều hỗ trợ lưu trữ ở nhiều dạng, trong đó dạng *.txt là dạng văn bản trơn: [Word 

Document (*.doc) > File > Save As > Plain Text (*.txt)]. 

 

◊ Đã biết mã của văn bản nguồn 

Ví dụ: Ta có một tệp văn bản trơn, là câu ca dao về ơn nghĩa cha mẹ, mà ta đã biết là gõ bằng 

bảng mã (bộ chữ) VIQR. 

 

 
 

Hình 12:  Văn bản viết dưới dạng VIQR (còn gọi là VietNet) 
 

Tệp này ta đặt tên là ChaMe.txt và chứa trong thư mục (directory) C:\CaDao. 

Nay ta muốn chuyển mã tệp này qua mã Unicode và lưu giữ (save) nó dưới tên tệp tương tự 

trong một ngăn tiểu thư mục (subdirectory) khác. Ta làm các bước sau đây: 
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Hình 13: Hoán chuyển văn bản trơn 

 

1. Chọn [Trang Chính (Main) >  Chạy (Run) > Hoán chuyển]. 

2. WinVNKey sẽ hiển thị bảng Hoán Chuyển như Hình 13, ta điền thông số thích hợp vào ô 

“Tệp nguồn” và ô “Tệp đích” ở trang “Văn Bản Trơn”. 

3. Trong hàng “Văn bản nguồn”, chọn [Tệp] và [3.VIQR (Vietnet)] vì tệp nguồn ở mã VIQR. 

4. Trong hàng “Văn bản đích”, chọn [Tệp] và [4.Unicode] vì ta muốn chuyển tệp qua mã 

Unicode. 

5. Trong nhóm “Tệp nguồn”, nhấn nút có hình mở tệp  để đến thư mục và chọn đúng 

tệp nguồn. 

6. Trong nhóm “Tệp đích”, chọn tùy chọn [Cùng tên tệp, khác tên tiểu thư mục] theo cách 

như Hình 14: 

 

 
 

Hình 14: Chọn cách tạo ra tệp đích 
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(WinVNKey sẽ tự động điền vào ô “Thư mục” và ô “Tên tệp” ở nhóm “Tệp đích”. Nếu ta không 

thích các tên tệp và tên thư mục mà WinVNKey điền vào thì ta có thể sửa chúng lại theo ý riêng 

của ta). 

 

7. Nhấn nút “Hoán chuyển” để chuyển mã. 

8. Xem thông tin kết quả trong hộp “Kết quả”. 

9. Khi chữ hiện ra là “xong”, ta có thể xem lại kết quả chuyển mã ở tệp ChaMe.txt bằng 

cách nhấp mũi tên ở chữ màu xanh “Tên tệp”. Tệp ChaMe.txt sẽ hiện ra như Hình 15: 

 

 

 
 

Hình 15: Kết quả hoán chuyển văn bản dạng VIQR sang Unicode 

 

◊  Không biết mã của văn bản nguồn 

WinVNKey có thể tự đoán được mã của văn bản nguồn. Cũng cùng ví dụ tệp ChaMe.txt ở trên, 

nếu ta không biết chắc chắn mã của văn bản nguồn là mã gì, ở bước thứ 4, ta có thể chọn ["0. Tự 

động đoán bộ chữ ”] ở hàng “Văn bản nguồn” như Hình 16: 
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Hình 16:  Nhờ WinVNKey đoán bảng mã nguồn 

 

Sau đó, ta nhấn nút “Hoán chuyển”, hộp “Kết quả” sẽ cho thấy kết quả đoán bảng mã và kết quả 

chuyển mã. Nếu kết quả chuyển mã bị sai, ta có thể nhấn lên cụm chữ xanh "Kết quả" để xem 

chi tiết của việc đoán mã. Ta sẽ thấy danh sách các bảng mã được liệt kê dựa theo số lượng chữ 

sai chính tả từ ít lỗi nhất đến nhiều lỗi nhất. Bảng mã được chọn chính là bảng mã đầu tiên có ít 

chữ sai chính tả nhất. Trong trường hợp có nhiều bảng mã đồng hạng (có cùng số chữ sai chính 

tả), trên lý thuyết ta có thể chọn bất cứ bảng mã nào làm bảng mã nguồn cũng được.   

 

Nếu việc chọn bảng mã đầu tiên này cho ra kết quả hoán chuyển sai, ta hãy hoán chuyển lại.  

Lần này, ta chọn bảng mã nguồn là bảng mã thứ nhì (có ít lỗi thứ nhì) chứ không nên chọn "0. Tự 

động đoán bộ chữ”. Cứ tiếp tục quá trình này chừng một vài lần, ta sẽ có kết quả chuyển mã 

đúng. 

 

Trong thực tế, nếu gặp văn bản toàn tiếng Anh (tức bảng mã ASCII), kết quả đoán mã sẽ cho 

nhiều đáp số vì hầu hết tất cả các bảng mã tiếng Việt đều có chứa bảng mã ASCII. Trong trường 

hợp này, ta có thể nói văn bản dùng bảng mã ASCII (chính xác nhất) mà cũng có thể nói văn bản 

dùng bảng mã VISCII, VNI, VPS, ABC, v.v.  Khi tiến hành đổi thì bảng mã nào cũng sẽ cho ra kết 

quả giống nhau. 
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B. Chuyển mã từ clipboard bằng hộp thoại Hoán Chuyển 
 

Nếu ta chỉ có nhu cầu chuyển mã một đoạn văn bản mà thôi, cách tốt nhất là copy đoạn văn bản 

đó vào clipboard rồi dùng chức năng chuyển mã từ Clipboard. Chức năng này chỉ thuần túy hoán 

chuyển mã của các chữ mà gạt bỏ tất cả các thông tin về định dạng, nghĩa là chỉ hoán chuyển nội 

dung mà thôi. Do đó, ta có thể chuyển mã trên từng đoạn văn bản của tệp ở bất cứ dạng nào: 

*.doc, *.txt, Notepad, v.v… 

 

Ví dụ: Tôi mới mua máy vi tính. Trong máy có Microsoft Word và chỉ có các phông của mã 

Unicode (như Arial, Tahoma, Times New Roman …); chứ chưa tải xuống phông của các mã tiếng 

Việt nào khác, ngoài Unicode. Nay bạn tôi gởi cho tôi một bài ca dao tệp (file) Hoa sen.doc gõ 

trên Microsoft Word và gởi qua email ở bản đính kèm (Attachment). Khi mở tệp ở Attachment ra, 

tôi thấy như Hình 17: 

 

 
 

Hình 17: Văn bản không đọc được vì dùng phông không đúng với bảng mã. 

 

Tôi không biết bài ca dao trên được bạn tôi gõ bằng bảng mã gì, nên để đọc được cũng như để 

lưu giữ bài ca dao ở mã Unicode, tôi làm các bước như sau: 
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Hình 18: Hoán chuyển văn bản nằm trong clipboard 

 

1. Trong Microsoft Word, chọn bôi đen văn bản rồi copy [Select All > Copy] thì toàn bộ 

văn bản sẽ được đưa vào bộ nhớ bảng ghi tạm (clipboard). 

2. Khởi động WinVNKey. 

3. Chọn [Trang Chính (Main) >  Chạy (Run) > Hoán chuyển]. 

4. WinVNKey sẽ hiển thị bảng Hoán Chuyển, ta chọn thông tin thích hợp cho hàng “Văn 

bản nguồn” và hàng “Văn bản đích” ở trang “Văn Bản Trơn” như Hình 18 ở trên. 

5. Nhấn nút “Hoán chuyển”. 

6. Xem kết quả chuyển mã trong hộp “Kết quả”. 

7. Trở lại Microsoft Word, chọn [Edit > Paste] để dán toàn bộ văn bản vừa được chuyển 

mã ở bảng ghi tạm trở lại MS Word. Kết quả như Hình 19: 

 



 19 

 
 

Hình 19: Văn bản sau khi copy trở lại từ clipboard 

 

Lưu ý: Trong bước 1, ta có thể chọn bôi đen chỉ một phần của tệp. Ta cũng có thể dùng [Cut] 

thay vì [Copy]. 

 
C. Chuyển mã từ clipboard bằng trình đơn (menu)  
 

Phương pháp chuyển mã từ clipboard vừa trình bày ở trên tương đối mất thời giờ vì phải thông 

qua hộp thoại Hoán Chuyển Văn Bản Trơn. WinVNKey hỗ trợ một phương pháp hoán chuyển rất 

nhanh như sau. 

 

1. Chọn bôi đen một đoạn văn bản. 

2. Nhấn thả phím Ctrl hai lần. 

3. Đè chuột phải để hiện ra menu hoán chuyển như Hình 3. 

4. Rồi nhấn chuột lên menu hoán chuyển B (Hình 3). 

5. Kết quả hoán chuyển sẽ lập tức thay thế đoạn chữ bôi đen mà ta không cần phải dán 

(paste) gì cả. 

 

Đôi khi ta chỉ muốn đổi để xem thử kết quả mà thôi chứ không muốn kết quả hoán chuyển thay 

thế đoạn chữ bôi đen. WinVNKey đã tiên liệu trường hợp này và cung cấp menu E1.  Cụ thể trong 

5 bước kể trên, bước (4) và (5) được thay thế như sau: 

 

4’. Rồi nhấn chuột lên menu hoán chuyển E1 (xem Hình 3) 

5’. Kết quả hoán chuyển sẽ được chứa trong một tệp nháp và hiển thị bằng Notepad. 

 

Làm sao WinVNKey biết bảng mã nguồn và đích để hoán chuyển? 

Trong bước 4 kể trên, làm sao WinVNKey biết bảng mã nguồn và đích mà hoán chuyển cho đúng? 

Câu trả lời là WinVNKey dựa vào thông tin ở menu C (Hình 3).  Nếu bảng mã liệt kê ở menu C 

không đúng ý muốn, người dùng có thể nhấn vào menu này để hiện ra hộp thoại chọn bảng mã 

như Hình 20.    
 



 20 

 
 

Hình 20: Hộp thoại cho phép chọn trước mã nguồn và mã đích. 

 

Hộp này có 2 combobox chứa danh sách bảng mã nguồn và bảng mã đích. Hai danh sách này 

giống hoàn toàn như hai danh sách sách bảng mã nguồn và bảng mã đích trong hộp thoại Hoán 

chuyển Văn bản trơn ở Hình 13. Sau khi chọn xong bảng mã nguồn và đích, ta nhấn OK thì hai 

bảng mã này sẽ có hiệu lực vĩnh viễn cho menu B và E1 ngoại trừ khi ta chọn lại khác hơn. 

 

D. Chuyển mã từ clipboard bằng phím nóng 
 

Nếu để ý nhìn menu hoán chuyển ở Hình 3, ta sẽ thấy như sau: 

 Menu B có shortcut <CTRL-C> <CTRL> <B>, nghĩa là nhấn CTRL-C để copy, rồi nhấn 

thả phím Ctrl một lần, xong nhấn phím B (đừng nhấn phím Shift). 

 Menu E1 có shortcut <CTRL-C> <CTRL> <D>, nghĩa là nhấn CTRL-C để copy, nhấn thả 

phím Ctrl một lần, xong nhấn phím D (đừng nhấn phím Shift) và chuột. 

 

Tóm lại, thay vì dùng chuột, ta có thể dùng phím nóng như sau: 

 

1. Để hoán chuyển và thay thế trực tiếp trong văn bản: 

- Chọn bôi đen một đoạn văn bản. 

- Nhấn chuỗi phím <CTRL-C> <CTRL> <B>. 

 

2. Để hoán chuyển và hiển thị trong tệp nháp: 

- Chọn bôi đen một đoạn văn bản. 

- Nhấn chuỗi phím <CTRL-C> <CTRL> <D>. 

 

7. HOÁN CHUYỂN VĂN BẢN DẠNG TELEX, VNI, VIQR (VietNet) 

 

Giả sử một người bạn muốn gửi cho ta một đoạn văn như sau: 

 

Thí dụ: 
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Phấn son tô điểm sơn hà  

Làm cho rỡ mặt đàn bà nước Nam.  

 

Nhưng người ấy lo ngại người nhận không đọc được vì không có đúng phông nên đã quyết định 

gửi đoạn văn đó dưới dạng một trong những qui ước sau đây: 

 

(1) Telex tiêu chuẩn: 

Phaasn son too ddieerm sown haf  

Lafm cho rowx mawjt ddafn baf nuwowsc Nam.  

 

(2) Qui ước dùng dấu theo cách gõ VNI tiêu chuẩn: 

Pha61n son to6 d9ie63m so7n ha2  

La2m cho ro74 ma85t d9a2n ba2 nu7o71c Nam.  

 

(3) Qui ước VIQR (VietNet) tiêu chuẩn: 

Pha^'n son to^ ddie^?m so+n ha`  

La`m cho ro+~ ma(.t dda`n ba` nu+o+'c Nam.  

 

Vấn đề đặt ra là làm sao ta có thể dùng WinVNKey để đổi các đoạn văn (1-3) trở về dạng chữ 

Việt thực sự. 

 
A. Hoán chuyển như một bảng mã 
 

Mỗi chữ (character) trong những đoạn văn trên (1–3) đều là những chữ nằm trên bàn phím Mỹ, 

nghĩa là bảng mã của chúng đều là bảng mã ASCII. Nếu xét theo khía cạnh từng ký tự một thì 

các đoạn văn này là bảng mã ASCII. Nhưng nếu chọn bảng mã nguồn là ASCII thì mỗi ký tự 

trong đoạn văn trên đều là ký tự Việt cả, nên sau khi đổi xong ta sẽ được kết quả giống hệt như 

đoạn văn nguồn. 

 

Vấn đề mấu chốt ở đây là làm sao kết hợp các chuỗi ký tự lại thành một ký tự có dấu, chẳng hạn, 

kết hợp ba ký tự a^' thành chữ ấ.  Để giải quyết điều này, WinVNKey tạm thời coi qui ước Telex, 

VNI, VIQR như là những bảng mã chữ Việt. Các bảng mã này được liệt kê ở menu số đánh số 47 

(cho Telex), hoặc 48 (cho VNI), hoặc số 3 (VIQR) như trong Hình 21.   

 

Do đó, muốn hoán chuyển các đoạn văn trên sang chữ Việt thực sự, ta chọn như sau: 

- Đoạn văn (1) có mã nguồn là Telex (menu số  47) 

- Đoạn văn (2) có mã nguồn là VNI (menu số  48) 

- Đoạn văn (3) có mã nguồn là VIQR (menu số  3) 

- Còn văn bản đích thì chọn bảng mã Unicode hoặc bất cứ bảng mã nào ta muốn. 

 

 
 

Hình 21: Chọn menu thích hợp với qui ước dấu trong văn bản nguồn. 
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B. Gõ lại toàn bộ văn bản 
 

Bây giờ ta hãy tiếp tục thí dụ ở tiểu mục A ở trên. Giả sử người bạn không tuân theo đúng qui 

ước tiêu chuẩn mà lại tùy tiện dùng một số dấu đặc biệt, tuy được nhiều người dùng, nhưng lại 

không nằm trong tiêu chuẩn được chính thức công nhận.  Chẳng hạn, 

 

(4) Telex tùy tiện (dùng dấu [ cho ư và  dấu ] cho ơ) 

                 Phaasn son too ddieerm sown haf  

                 Lafm cho rowx mawjt ddafn baf n[]sc Nam.  

 

(5) Qui ước VietNet tùy tiện (dấu trăng là <, dấu mũ là ^, dấu móc là *) 

                 Pha>'n son to> d-ie>?m so*n ha`  

                 La`m cho ro*~ ma<.t d-a`n ba` nu*o*'c Nam.  

 

Nói chung, khi văn bản nguồn dùng qui ước dấu một cách tùy tiện như thế này, muốn hoán 

chuyển được thì WinVNKey phải đặt ra thêm nhiều menu: Telex 1, Telex 2, Telex 3, ..., hoặc 

VietNet 1, VietNet 2, ... Nhưng dù có đặt ra thêm thì cũng không thế nào lường trước được các 

dấu tùy tiện sẽ thay đổi như thế nào. Do đó, việc đặt thêm menu là chuyện không thực tế. 

 

Nếu phân tích kỹ các đoạn văn (4-5) trên đây thì thấy chúng thực sự giống hệt các chuỗi phím 

chữ mà người dùng gõ vào văn bản khi gõ chữ Việt bằng một trong các phần mềm như 

WinVNKey, v.v.  Nhưng nếu lúc gõ người dùng tắt phần mềm này, thì kết quả là các dấu không 

kết hợp như các đoạn văn trên đây. 

 

Từ nhận xét này, ta có thể thấy ngay cách giải quyết việc hoán chuyển đoạn văn (4) và (5) trên 

đây như sau: 

- Trước hết chọn hoặc điều chỉnh kiểu gõ sao cho phù hợp với qui ước dấu trong văn bản 

nguồn. 

- Sau đó gõ lại văn bản nguồn từ đầu đến cuối. 

- Nhưng nếu ta phải tự gõ lại, sao không nhờ WinVNKey tự gõ lại dùm cho ta? 

 

1. Tự mình gõ lại toàn bộ văn bản 

Đây là cách đơn giản nhất, nhưng mất thời gian nhất.   

 

a. Thí dụ 1: Chuyển dạng Telex của đoạn văn (4) sang tiếng Việt:  

Chọn kiểu gõ là "9. Telex 2" rồi gõ lại đoạn văn (4). 

 

b. Thí dụ 2: Chuyển dạng VietNet của đoạn văn (5) sang tiếng Việt :  

Chọn kiểu gõ là "5. VietNet".  Nhưng trước khi gõ lại đoạn văn (4), ta hãy nhấn lên hyperlink 

"Kiểu gõ" ở trang Chính để xem xét lại qui ước về dấu có khớp với qui ước trong đoạn văn (5) hay 

không (Hình 22).   
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Hình 22: Qui ước dấu dùng trong kiểu gõ "5. VietNet" 

 
Đoạn văn (5) dùng qui ước dấu mũ là > và dấu trăng là <, nhưng dấu mũ > không có trong Hình 

19. Như vậy, ta cần điều chỉnh WinVNKey bằng cách gõ thêm dấu > vào các ô nằm dưới các mẫu 

tự â, ê, và ô như trong Hình 23. WinVNKey cho phép ta định nghĩa tối đa 4 ký tự cho mỗi dấu 

(muốn biết thêm chi tiết, nhấn lên icon hình chữ â, ê, v.v.).  Sau khi điều chỉnh xong, ta gõ lại 

đoạn văn (5) từ đầu. 

 
 

 
 

Hình 23: Cho phép cả hai dấu ^ và > tượng trưng dấu mũ. 
 
2. Nhờ WinVNKey tự động gõ lại toàn bộ văn bản 

Cách nhanh nhất là nhờ WinVNKey tự động gõ lại văn bản nguồn dùm cho ta. Nhưng trước hết, ta 

phải cài đặt kiểu gõ cho đúng với văn bản nguồn. Nếu cần, ta phải sửa lại qui ước dấu cho khớp 

với dấu dùng trong văn bản nguồn, chẳng hạn như trong thí dụ 2 ở tiểu mục trên.   

 

Hình 24 dưới đây cho thấy tất cả các menu hoán chuyển từ số 200 trở đi là menu tự động gõ lại 

văn bản nguồn.   

 

 Menu số 200 là cách gõ lại dựa theo các thông số của bàn phím hiện thời.  

 Menu số 201 đến 215 tương ứng với các kiểu gõ từ số 1 đến số 15 ở trang Chính.   

 

Khi chọn một trong những menu này, ta không cần phải thay đổi cách cài đặt bàn gõ ở bất cứ 

trang nào.  
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Hình 24: Menu cho phép WinVNKey tự động gõ lại văn bản nguồn. 

 

a. Menu 200 

Khi chọn menu nay, ta sẽ thấy hiện ra như Hình 25. 

 

 
 

Hình 25: Chuyển văn bản nguồn bằng cách tự động gõ lại. 

 

Ta có thể nhấn nút có dấu hỏi để xem giải thích chi tiết về cách tự động gõ lại này. Cụ thể, 

phương pháp này dùng tất cả các thông số hiện tại của WinVNKey, chẳng hạn Cách kết hợp dấu 

và Macro ở trang Chính, chọn các ngôn ngữ ở trang Ngôn Ngữ, các tùy chọn ở trang Cao cấp, v.v. 

 

b. Menu 201 đến 215 

Khi chọn menu này và nhấn nút có dấu ">>", ta sẽ thấy như Hình 26. Cụ thể, phương pháp này 

khác với Menu 200 ở chỗ nó chỉ dựa vào các thông số của Kiểu gõ và Cách kết hợp dấu mà thôi, 

và các thông số này hoàn toàn độc lập với trang Chính. Chẳng hạn, Hình 24 đã chọn Kiểu gõ là 

"205. VietNet" và Cách kết hợp dấu là "1. Vần kiểu VietNet (Gõ dấu sau chữ cái, kết hợp nếu là 

vần Việt)", trong khi đó trang Chính có thể có kiểu gõ khác và Cách kết hợp dấu khác. Do đó, khi 

chọn menu từ 201 đến 215, các tùy chọn ở trang Chính, Ngôn ngữ, Cao cấp, Macro, v.v. không 

hề ảnh hưởng đến việc gõ lại. Chú ý rằng nếu muốn điều chỉnh lại các tùy chọn của Kiểu gõ và 

Cách kết hợp dấu, ta phải trở về trang Chính và nhấn lên các hyperlink tương ứng. 
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Hình 26: Chọn gõ lại dùng Kiểu gõ và Cách kết hợp dấu riêng biệt 

 

8. HOÁN CHUYỂN VĂN BẢN VIQR MỘT CÁCH THÔNG MINH 

 

Việc hoán chuyển văn bản dạng VIQR (VietNet) đã được trình bày ở mục số 7. Phần này sẽ đề 

cập một cách chi tiết hơn vì hiện nay vẫn còn rất nhiều thông tin bài vở đăng dưới dạng VIQR, 

chẳng hạn diễn dàn nhóm soc.culture.vietnamese trên Internet hay các nhóm điện thư (mailing 

list). 

 

A. Dạng VietNet có thể bị hoán chuyển sai lạc ý nghĩa 
 

Văn bản viết dưới dạng VIQR có lợi điểm là không bị biến dạng khi gửi qua email hoặc các môi 

trường điện toán khác nhau (Windows, Dos, Unix, Linux, Mac). Ngoài ra trong trường hợp không 

có phần mềm hoán chuyển, người dùng vẫn có thể đoán ra ý nghĩa, dù tốc độ đọc chậm hơn, vì 

các ký hiệu tượng trưng cho dấu phụ có hình dạng tương tự như dấu tiếng Việt. Chẳng hạn, khi 

đọc hai câu dưới đây thì hầu như ai cũng có thể đoán ra nghĩa của chúng. 

 (a) Cha(?ng co' chi. 

(b) To^i no'i chuye^.n vo+'i chi. Thanh. 

 

Tuy nhiên, dấu chấm và dấu chấm hỏi trong văn bản VIQR tạo ra nhiều trường hợp hoán chuyển 

lầm lẫn vì chúng có thể vừa dấu ngắt câu vừa là dấu thanh khi chúng đứng ngay sau một nguyên 

âm.    

 

Trong thí dụ trên, cùng viết là "chi.", nhưng dấu chấm đóng vai trò là dấu chấm câu trong ví dụ 

(a) và là dấu thanh trong câu (b). Sở dĩ ta biết được điều này là vì bộ não của ta xử lý một cách 

nhanh chóng và tự động gạt bỏ những chữ vô lý. Thật vậy, bộ não của ta xử lý như sau: 

• Chẳng có chi.   

Chọn chi. hay chị ?  Não tự động loại bỏ chữ chị vì câu văn "Chẳng có chị" nghe ngớ ngẩn hơn 

câu văn "Chẳng có chi". 

• Tôi nói chuyện với chị Thanh. 

Chọn chi. hay chị?  Não tự động loại bỏ chữ "chi." vì chữ này làm cho câu văn trở thành ngớ ngẩn 

hơn là chữ "chị". 

 

Nhưng máy điện toán không có khả năng phán xét như thế này trừ khi ta lập kho dữ liệu đồ sộ 

chứa tất cả các câu thường dùng để nó có thể so sánh. 
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Để giải quyết sự mù mờ này, qui ước VIQR tiêu chuẩn đòi hỏi ta phải chèn dấu thoát (escape 

character) trước một dấu ngắt câu thực sự để báo cho biết dấu đó không phải là dấu thanh.  

WinVNKey chọn dấu thoát mặc định là dấu chéo ngược \  (xem trang Phím đặc biệt trong Hình 

27). 

 

 
 

Hình 27: Trang Phím đặc biệt cho phép tự chọn phím thoát 

 

B. Dùng dạng VIQR chuẩn để tránh sai lạc ý nghĩa 
 

Theo qui ước VIQR tiêu chuẩn, ta phải chèn dấu thoát trước dấu chấm của câu (a), nghĩa là phải 

viết (a) và (b) như sau: 

 (a') Cha(?ng co' chi\. 

(b') To^i no'i chuye^.n vo+'i chi. Thanh. 

 

Tuy nhiên không phải ai cũng biết qui luật này, cũng như có người biết mà không dùng vì nó làm 

cho văn bản khó đọc hơn. Chính vì lý do này mà ta thấy tuyệt đại đa số các bài đăng trên diễn 

đàn soc.culture.vietnamese không dùng dấu thoát. Còn về chữ tượng trưng cho dấu, mỗi người 

dùng một kiểu: có người chọn < cho dấu trăng, > cho dấu mũ, / cho dấu sắc, \ cho dấu huyền. 

 

Để giúp cho độc giả của các diễn đàn này có thể hoán chuyển văn bản VietNet sang chữ Việt thực 

sự, WinVNKey cung cấp rất nhiều chức năng nhanh chóng và thông minh. 

 

C. Hoán chuyển nhanh chóng dạng VIQR sang Unicode 
 

1. Hoán chuyển nhanh từ VIQR sang Unicode bằng chuột và menu: 

 Dùng chuột bôi đen văn bản VIQR (hoặc nhấn CTRL-A). 

 Nhấn thả phím Ctrl hai lần.  

 Đè chuột phải để hiện menu như Hình 3. 
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 Nhấn lên menu E2 hoặc E3. 

 Kết quả hiện ra trong Notepad với tên tệp là clipbd.txt. 

 

2. Hoán chuyển nhanh từ VIQR sang Unicode bằng phím nóng: 

 Chọn bôi đen văn bản VIQR (nhấn CTRL-A chẳng hạn). 

 Nhấn Ctrl-C để copy. 

 Nhấn thả phím Ctrl. 

 Nhấn thả phím V hoặc A. 

 Kết quả hiện ra trong Notepad với tên tệp là clipbd.txt. 

 

D. Hoán chuyển thông minh 
 

WinVNKey cho phép thay đổi qui ước về dấu, thay đổi qui luật kết hợp dấu (bỏ dấu tự do hay 

phải bỏ dấu sát ngay sau nguyên âm), qui định khi nào kết hợp hoặc không kết hợp dấu chấm 

(hoặc chấm hỏi) ở cuối câu. Để thấy được chức năng này, ta có thể: 

 

• Nhấn thả phím Ctrl 2 lần, xong đè chuột phải để hiển thị menu như Hình 3, rồi nhấn menu D.  

• Hoặc nhấn nút ">>" của hộp thoại hoán chuyển văn bản trơn ở Hình 13. 

 

Khi đó, WinVNKey sẽ hiển thị hộp thoại như Hình 28. 

 

 
 

Hình 28: Chọn thông số cho hoán chuyển văn bản dạng VIQR. 
 

Sau đây là mô tả sơ lược Hình 28: 

• Nhấn lên hyperlink A để diều chỉnh qui ước về dấu sao cho phù hợp với văn bản nguồn. 

• Nhấn lên hyperlink B để điều chỉnh các thông số của cách kết hợp dấu. 

• Nhấn lên combobox dưới hyperlink B để chọn cách kết hợp dấu. 

• Chức năng C: chọn cách xử lý dấu chấm khi nó ở cuối câu mà lại nằm sau nguyên âm.  Hình 28 

đang dùng tùy chọn 2, nghĩa là luôn luôn kết hợp dấu chấm với nguyên âm, trừ khi dấu chấm đó 

ở cuối một số từ.  Số từ này được liệt kê trong một tệp riêng, có thể mở ra để thay đổi bằng cách 

nhấn lên nút ">>" bên cạnh. 
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• Chức năng D: chọn cách xử lý dấu chấm hỏi khi nó ở cuối câu mà lại nằm sau nguyên âm. Hình 

27 đang dùng tùy chọn 2, nghĩa là luôn luôn kết hợp dấu chấm hỏi với nguyên âm, trừ khi dấu đó 

ở cuối một số từ.  có thể mở ra để thay đổi bằng cách nhấn lên nút ">>" bên cạnh. 

• Nhấn lên hyperlink E và F để xem giải thích chi tiết. 

 

9. HOÁN CHUYỂN PHÔNG CHO VĂN BẢN ĐỊNH DẠNG RTF 
- Hệ thống font Unicode. Đây là các hệ font chuẩn quốc tế, được cài đặt ngay trong bản thân Windows. Từ hệ điều hành WIndows 98 SE trở 

WinVNKey có khả năng hoán chuyển văn bản RTF từ nhiều phông nguồn sang nhiều phông đích 

khác nhau. Khi WinVNKey hoán chuyển phông, nó cũng tự động đổi luôn bảng mã (bộ chữ) của 

phông nguồn sang bảng mã của phông đích mà không cần người dùng.  

 

Chức năng hoán chuyển văn bản RTF của WinVNKey có đặc điểm là bảo toàn kiểu phông, màu 

sắc, đậm lợt, cỡ chữ, loại chữ nghiêng, v.v. của văn bản nguồn. 

 

Để hoán chuyển văn bản RTF, ta phải lưu trữ (save) văn bản ở dạng *.rtf. Cách lưu trữ: [Word 

Document (*.doc) > File > Save As > Rich Text Format (*.rtf)]. 

Ví dụ: Một nhà xuất bản có một tệp văn bản “Tuyển Tập Truyện Ngắn” (Tuyen Tap Truyen 

Ngan.doc) viết bằng MS Word Document với nhiều phông của Unicode hoặc VPS, hoặc TCVN khác 

nhau, kích cỡ khác nhau, màu sắc khác nhau. Nay muốn đổi sang phông VNI để in thành sách vì 

từ lâu đã hệ thống in ấn đã quen dùng phông chữ VNI, nhà xuất bản này có 3 chọn lựa như sau: 

 

(a) Mở tệp nguyên thủy ra, copy từng đoạn một, hoán chuyển mã, rồi paste trở lại. 

Phương pháp này đã được mô tả ở mục 6.C và 6.D.1 ở trên. 

 

(b) Hoặc lưu trữ (save) văn bản ở dạng *.txt rồi đổi từ văn bản trơn qua mã VNI, xong tự mình 

khôi phục lại định dạng. 

 

Khi lưu trữ văn bản ở dạng *.txt, tất cả thông tin về định dạng sẽ mất đi, chỉ còn nội dung văn 

bản mà thôi. Muốn phục hồi lại định dạng, ta phải tự làm lại từ đầu một cách thủ công: dùng 

Microsoft Word để mở văn bản, tự điều chỉnh lại định dạng, màu sắc, kiểu chữ sao cho giống với 

văn bản gốc, rồi cuối cùng lưu trữ văn bản ở dạng *.doc và in ra giấy. 

 

(c) Hoặc lưu trữ văn bản ở dạng *.rtf rồi nhờ WinVNKey đổi sang phông VNI. 

 

Sau khi đổi xong, văn bản mới sẽ hầu như giống hệt văn bản nguồn. Ví dụ nếu văn bản nguồn 

dùng phông Times New Roman hoặc VPS-Times thì văn bản đích sẽ tự động được đổi qua phông 

VNI-Times vì phông này gần giống phông Times New Roman hoặc VPS-Times. Có tinh mắt mới 

nhìn ra sự khác biệt giữa các phông VNI-Times, VPS-Times và Times New Roman. 

 

Nếu nhà xuất bản chọn cách (c) thì phải làm các bước như sau: 
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Hình 29: Hộp thoại hoán chuyển văn bản định dạng RTF. 

 

 

Dùng Microsoft Word để mở tệp “Tuyển Tập Truyện Ngắn”. Giả sử tệp này là “Tuyen Tap Truyen 

Ngan.doc” nằm trong thư mục (directory) “C:\Download”. 

 

1. Lưu trữ tệp này ở dạng *.rtf [Word Document (*.doc) > File > Save As > Rich Text 

Format (*.rtf)]. 

2. Chọn [Trang Chính (Main) >  Chạy (Run) > Hoán chuyển].  WinVNKey sẽ hiển thị bảng 

Hoán Chuyển như Hình 29. 

3. Điền thông số thích hợp vào nhóm “Tệp nguồn” và nhóm “Tệp đích” ở trang “Văn Bản RTF” 

như hình này. 

4. Trong nhóm “Chọn bảng đổi phông - Bảng”, chọn [Đổi sang phông VNI] vì ta muốn 

chuyển tệp qua phông VNI. 

5. Trong nhóm “Tệp nguồn”, nhấn nút có hình mở tệp  để đến thư mục và chọn đúng 

tệp nguồn. 

6. Trong nhóm “Tệp đích”, chọn tùy chọn [Cùng tên tệp, khác tên tiểu thư mục] theo Hình 30 

như sau: 
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Hình 30:  Chọn thư mục cho tệp đích. 
 

7. (WinVNKey sẽ tự động điền vào ô “Thư mục” và ô “Tên tệp” ở nhóm “Tệp đích”. Nếu ta 

không thích các tên tệp và tên thư mục mà WinVNKey điền vào thì ta có thể sửa chúng lại 

theo ý riêng của ta). 

8. Nhấn nút “Hoán chuyển” để chuyển phông. 

9. Xem thông tin kết quả trong hộp “Kết quả”. 

10. Khi chữ hiện ra là “xong”, ta có thể xem lại kết quả chuyển phông ở tệp Tuyen Tap 

Truyen Ngan.rtf  bằng cách nhấp mũi tên ở chữ màu xanh “Tên tệp”. 

11. Sau cùng, lưu giữ tệp này ở dạng nguyên thủy *.doc [Rich Text Format (*.rtf) > File > 

Save As > Word Document (*.doc)]. 

 

Từ ví dụ trên, ta có thể chuyển từ phông này sang phông khác một cách dễ dàng, chẳng hạn ta 

có bài viết trong máy dùng phông chữ VISCII, TCVN, VPS, VNI, …  ta có thể đổi sang phông của 

Unicode rồi đưa lên mạng một cách rất nhanh chóng. 

 

Nói chung, chức năng hoán chuyển văn bản RTF của WinVNKey rất phong phú. Trên đây chỉ một 

ví dụ căn bản mà thôi. Muốn biết chi tiết, ta xem thêm phần “Hướng dẫn” ở trong khung “Đổi 

Phông RTF” [Trang Chính WinVNKey > Chạy > Hoán chuyển > Văn bản RTF > Bảng > Mũi tên 

màu đen kế chữ Bảng] 

 

Cần nói thêm, có sự khác biệt giữa các phần mềm khác và WinVNKey về hoán chuyển văn bản 

RTF. 

 

◊ Các phần mềm khác: Coi toàn bộ văn bản được viết theo 1 bảng mã duy nhất, thí dụ là VNI.  

Rồi tiến hành đổi mã, xong đổi tên fonts. Vì lý do này, nếu tệp nguồn có chứa nhiều bảng mã (có 

đoạn dùng VNI, có đoạn dùng VPS, có đoạn dùng ABC, có đoạn dùng Unicode, v.v.) thì các phần 

mềm này không đổi được. 

 

◊ WinVNKey: Ta không cần chọn bảng mã nguồn và bảng mã đích. Ta có thể dùng nhiều loại 

phông/bảng mã khác nhau trong tệp nguồn (có nghĩa là có thể có một số cụm chữ là VNI, một số 

cụm chữ khác là VPS, v.v.) 

Ta có thể quyết định tên phông đích. Thí dụ, khi đổi ra phông Unicode, ta có thể chọn như sau: 

 

 Tất cả phông nguồn tựa tựa như Courier (VISCII phông Minh Quan, VNI phông Aptima, 

VPS phông x nào đó, v.v.) ta có thể chọn đổi ra Courier New. 

 Tất cả phông nguồn tựa tựa như Times (VISCII phông VI Times, VNI phông VNI-Times, 

VPS phông x nào đó giống Times, …) ta có thể chọn đổi ra Times New Roman. 

 

10. KẾT LUẬN 

Ngoài các chức năng đặc biệt được trình bày ở trên, WinVNKey còn nhiều chức năng đa dạng 

khác. Muốn tìm hiểu các chức năng này, khi chạy WinVNKKey, chỉ cần nhấn các chữ màu xanh 

(hyperlinks) liên hệ để được giải thích tỉ mỉ. 

 

WinVNKey là phần mềm gõ chữ Việt và các ngôn ngữ khác trong môi trường Windows do nhóm 

thảo chương TriChlor tại Hoa-Kỳ thực hiện từ năm 1992. Kể từ phiên bản 4.x.x trở đi, TS Ngô 

Đình Học đã nâng cấp WinVNKey lên thành bộ gõ đa ngữ. WinVNKey chạy trên Windows 

NT/2K/XP/2003/Vista. 
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Riêng những ai chưa thạo dùng máy vi tính, có thể đọc thêm bài “Hướng dẫn cấp tốc phần mềm 

gõ WinVNKey” ở http://chuvietnhanh.sf.net . Bài này hướng dẫn cách hạ tải, cài đặt WinVNKey 

vào máy, cách chọn các chức năng thường dùng trong WinVNKey. 

 

************************************** 

 

PHỤ LỤC 
 

Vài điều căn bản về 

QUẢN LÝ PHÔNG TIẾNG VIỆT CHO WINDOWS 
 

(Phần Phụ Lục được viết phỏng theo Lê Hoàn – Mediazone) 

 
 

1. Bao nhiêu phông thì đủ dùng? 

2. Cách cài thêm phông chữ. 

3. Cách bỏ bớt phông chữ. 

 

 

1. Bao nhiêu phông thì đủ dùng? 

 

Việc cài đặt phông cho Windows nhiều hay ít tùy vào nhu cầu của người sử dụng, nhưng số lượng 

quá lớn cũng sẽ làm ảnh hưởng đến tốc độ làm việc của Windows. Đối với đa số người dùng, số 

lượng phông cơ bản được Windows cung cấp sẵn là đủ dùng, không cần phải cài đặt thêm. 

 

Tuy nhiên, một số phần mềm gõ tiếng Việt hay đồ họa khi cài đặt sẽ tự động bổ sung thêm rất 

nhiều phông vào Windows, và việc cài đặt các bộ phông tiếng Việt với đủ loại bảng mã (ABC, 

VISCII, VNI, VPS, BK,  …) cũng làm tăng đáng kể tổng số phông. Để giảm bớt số lượng phông 

của Windows, bạn có thể thực hiện theo các nguyên tắc sau: 

- Để đọc văn bản tiếng Việt: Ta chỉ cần cài một phông đại diện cho một bảng mã tiếng Việt là bạn 

đủ khả năng đọc được tất cả văn bản tiếng Việt, thí dụ: chỉ cần cài một phông cho bảng mã VNI 1 

byte, một phông cho bảng mã VNI 2 byte là có thể đọc được tất cả văn bản được soạn thảo bằng 
phông VNI mà không cần cài cả bộ phông VNI với hàng trăm kiểu phông khác nhau.  

- Để in văn bản tiếng Việt: Bạn nên cài một bộ phông chuẩn có nhiều kiểu phông để phục vụ in 

ấn. Khi cần in văn bản được soạn với các bộ phông tiếng Việt khác, bạn nên hoán chuyển 

qua phông/mã của bộ phông chuẩn rồi tùy chọn kiểu phông phù hợp với kiểu phông nguồn trước 

khi in là xong.  

- Đối với phông tiếng Anh: Nếu ta không có nhu cầu chế bản chữ in thì không cần cài thêm bất cứ 
phông nào của các ứng dụng ngoài các phông chữ của Windows. 

 

2. Cách cài thêm phông chữ. 

 
Ta nhấn chuột: Start > chọn Control Panel > nhấn 2 lần lên biểu tượng Fonts. 

Trong cửa sổ Fonts, ta nhấn vào: File > Install New Font ... 

Tìm đường dẫn đến thư mục chứa phông cần cài đặt rồi chọn phông muốn cài đặt bằng cách nhấp 

chuột vào phông đó (giữ phím Ctrl nếu muốn chọn nhiều phông khác nhau) sau đó nhấn vào nút 

OK là phông sẽ được cài đặt. 

 

 

3. Cách bỏ bớt phông chữ. 

 

Ta nhấn chuột: Start > Control Panel > nhấn 2 lần lên biểu tượng Fonts. 

http://chuvietnhanh.sf.net/HuongDanCapTocPhanMemGoWinvnkey.htm
http://chuvietnhanh.sf.net/HuongDanCapTocPhanMemGoWinvnkey.htm
http://chuvietnhanh.sf.net/
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Trong cửa sổ Fonts, ta bấm nút cuối cùng bên phải của thanh công cụ để chọn kiểu liệt kê chi tiết 

(Details). Ta có thể nhấn 2 lần vào tên Fonts để xem kiểu chữ của nó như thế nào, và nếu có 

những phông ta không cần đến, có thể chọn xóa nó đi nhưng chú ý những điểm sau: 

- Không được xóa các phông có biểu tượng chữ A màu đỏ và chữ O màu xanh. 

- Chỉ nên xóa những phông có biểu tượng chữ TT và không trùng ngày với các phông cơ bản khi 

cài Windows. 

 

 

© Trần Tư Bình & TS. Ngô Đình Học (Web: Chữ Việt Nhanh, WinVNKey). 
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